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Note pour les utilisateurs Mac
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Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit +clic⌘ Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d’autres touches

F5 Maj+ +F5⌘ Ouvre le Navigateur

F11 +T⌘ Ouvre la fenêtre Styles & Formatage

La documentation de LibreOffice est disponible en anglais http://www.libreoffice.org/get-help/documentation
en français wiki.documentfoundation.org/FR/La_documentation_de_l’utilisateur 
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Apparence de LibreOffice

LibreOffice fonctionne sous les systèmes d’exploitation Windows, Linux et Mac OS X, chacun de
ces systèmes pouvant exister sous plusieurs versions. Chacune de ces configurations peut donner
lieu  à des options  d’affichage différentes (polices,  couleurs,  thèmes,  gestionnaire  de fenêtres,
icônes). De plus, ces options d’affichage sont pour certaines personnalisables par les utilisateurs.

Les illustrations  de ce chapitre  ont  été  réalisées sous Windows avec le  jeu  d’icônes  Galaxy.
Certaines  images  ne  ressembleront  donc  pas  exactement  à  ce  que  vous  voyez  sur  votre
ordinateur. En cas de confusion sur une icône, dont l’apparence peut être très différente d’un jeu à
l’autre, vous pouvez vérifier son nom, qui apparaît dans l’infobulle lorsque vous placez le pointeur
de  la  souris  au-dessus.  Pour  modifier  le  style  des  icônes,  sélectionnez  Outils  >  Options  >
LibreOffice > Affichage et dans la section Interface utilisateur choisissez la taille et le style des
icônes.

Qu’est-ce que Calc ?

Calc est le composant tableur de LibreOffice. Vous pouvez entrer des données (habituellement
numériques) dans une feuille de calcul et ensuite manipuler ces données pour produire certains
résultats.

Vous pouvez ensuite entrer des données et utiliser Calc dans une démarche ‘Et si...’ en changeant
certaines des données et en observant les résultats sans avoir à ressaisir tout le classeur ou toute
la feuille de calcul.

Les autres fonctionnalités fournies par Calc comprennent :

• les fonctions, qui peuvent être utilisées pour créer des formules afin d’effectuer des calculs
complexes sur les données ;

• les fonctions de base de données, pour classer, stocker et filtrer les données ;

• les graphiques dynamiques avec une grande variété de diagrammes 2D et 3D ;

• les macros, pour enregistrer et  exécuter des tâches répétitives ;  les langages de script
supportés comprennent LibreOffice Basic, Python, BeanShell et JavaScript ;

• la capacité d’ouvrir, de modifier et d’enregistrer des classeurs Microsoft Excel ;

• l’import et l’export de classeurs dans de multiples formats, dont HTML, CSV, PDF.

Note
Si vous voulez utiliser des macros écrites dans Microsoft Excel utilisant le code 
macro VBA dans LibreOffice, vous devez d’abord en modifier le code dans l’éditeur 
LibreOffice Basic IDE. Voir Chapitre 12 (Macros Calc).

Classeurs, feuilles de calcul et cellules

Calc fonctionne avec des éléments appelés classeurs. Les classeurs se composent d’un certain
nombre de feuilles individuelles, chaque feuille contenant des cellules disposées en lignes et en
colonnes. Une cellule particulière est identifiée par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent des éléments individuels – textes, nombres, formules, etc. – qui forment
les données à afficher et à manipuler.

Chaque  classeur  peut  avoir  plusieurs  feuilles,  et  chaque  feuille  peut  avoir  plusieurs  cellules
individuelles. Chaque feuille peut avoir au maximum 1 048 576 lignes (65 536 lignes dans Calc 3.2
et versions précédentes) et au maximum 1024 colonnes.
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Interface de Calc

Quand Calc est démarré, la fenêtre principale ressemble à la Figure 1.

Note

Si une partie de la fenêtre de Calc (Figure 1) n’apparaît pas, vous pouvez l’afficher 
en utilisant le menu Affichage. Par exemple, Affichage > Barre d’état va basculer 
(afficher ou masquer) la barre d’état. Il n’est pas toujours nécessaire de tout afficher, 
comme sur la Figure 1 ; affichez ou masquez ce que vous voulez.

Figure 1 : Espace de travail principal de Calc

Barre de titre
La barre de titre,  située en haut,  affiche le nom du classeur courant.  Lors de la création d’un
classeur, son nom est Sans nom X, où X est un nombre. Quand vous enregistrez un classeur pour
la première fois, vous devez saisir le nom de votre choix.

Barre de menus
En dessous de la barre de titre se trouve la barre de menus. Quand vous choisissez l’un des
menus, un sous-menu apparaît avec d’autres options. Vous pouvez modifier la barre de menus,
comme indiqué au chapitre 14, Paramétrer et personnaliser Calc, du Guide Calc.
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• Fichier contient  des  commandes  qui  s’appliquent  au document  entier,  comme  Ouvrir,
Enregistrer, Exporter au format PDF et Signatures numériques.

• Édition contient  des  commandes  pour  modifier  le  document,  comme  Annuler,
Modifications, Comparer le document et Rechercher & remplacer.

• Affichage contient des commandes pour modifier l’apparence de l’interface utilisateur de
Calc, comme Barres d’outils, Plein écran et Zoom.

• Insertion contient des commandes pour insérer des éléments, comme des  cellules, des
lignes, des colonnes, des feuilles et des images dans un classeur.

• Format contient  des  commandes  pour  modifier  la  présentation  d’un  classeur,  comme
Styles et formatage, Cellules et Fusionner les cellules.

• Outils contient des fonctions, comme Orthographe, Partager le document, Contenu des
cellules, Gallery et Macros.

• Données contient  des  commandes  pour  manipuler  les  données  dans  votre  classeur,
comme Définir la plage, Trier, Filtre et Table de pilote.

• Fenêtre contient des commandes pour la fenêtre d’affichage, comme  Nouvelle fenêtre,
Scinder et Fixer.

• Aide contient des liens vers le fichier d’aide fourni avec le logiciel, Qu’est-ce que c’est ?
et Vérifier les mises à jour.

Barres d’outils
Calc comporte plusieurs types de barres d’outils : ancrée (à place fixe), flottante et détachable. Les
barres d’outils ancrées peuvent être déplacées à différents endroits ou rendues flottantes, et les
barres d’outils flottantes peuvent être ancrées.

Trois barres d’outils sont situées sous la barre de menus par défaut : la barre d’outils Standard, la
barre d’outils Formatage et la barre de formule.

Les icônes (boutons) dans ces barres d’outils fournissent une large gamme de commandes et de
fonctions  ordinaires.  Vous  pouvez  également  modifier  ces  barres  d’outils,  comme  indiqué  au
chapitre 14, Paramétrer et personnaliser Calc, du Guide Calc.

Placer le pointeur de la souris sur chacune de ces icônes fait apparaître une petite boîte, appelée
info-bulle. Elle donne une brève explication de la fonction de l’icône. Pour une explication plus
détaillée, choisissez Aide > Qu’est-ce que c’est ? et placez le pointeur de la souris sur l’icône.
Pour désactiver cette fonction, cliquez dessus ou appuyez sur la touche Échap. Les astuces (info-
bulles) et les astuces détaillées (info-ballons) peuvent être activées ou désactivées depuis Outils
> Options > LibreOffice > Général.

Barre de formule
Du côté gauche de la Barre de formule se trouve une petite boîte de texte, appelée Zone de nom,
avec à l’intérieur la combinaison d’une lettre et d’un numéro, comme A1 dans la  Figure 2. Cette
combinaison, appelée référence de cellule, est la lettre de la colonne et le numéro de la ligne de la
cellule sélectionnée.

Figure 2 : Barre de formule
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À droite de la Zone de nom se trouvent les boutons Assistant Fonctions, Somme et Fonction.

Cliquer sur le bouton Assistant Fonctions ouvre une boîte de dialogue à partir de laquelle vous
pouvez effectuer une recherche dans une liste de fonctions disponibles. Ce peut être très utile
parce que cela montre également comment les fonctions sont formatées.

Dans un classeur, le mot  fonction recouvre davantage que les fonctions mathématiques. Voir  le
chapitre 7, Formules et fonctions, du Guide Calc pour plus de détails.

Cliquer sur le bouton Somme insère dans la cellule courante une formule qui totalise les nombres
des cellules situées au-dessus de la cellule courante. S’il n’y a pas de nombres au-dessus de la
cellule courante, la formule Somme utilise les cellules contenant des nombres situés à gauche.

Cliquer sur le bouton  Fonction insère un signe égal (=) dans la cellule sélectionnée et dans la
ligne de saisie, permettant ainsi à la cellule d’accepter une formule.

Quand vous entrez une nouvelle donnée dans une cellule, les boutons  Somme et  Fonction se
changent en boutons Annuler et Accepter .

Le contenu de la  cellule courante (donnée,  formule ou fonction) est  affiché dans la  Ligne de
saisie,  qui  est  le reste de la barre de formule.  Vous pouvez modifier  le contenu de la cellule
courante soit ici, soit dans la cellule courante. Pour modifier dans la zone Ligne de saisie, cliquez
dans la zone, puis tapez vos modifications. Pour modifier dans la cellule courante, double-cliquez
simplement dans la cellule.

Menus par clic droit (contextuel)
Un clic droit dans une cellule, un graphique ou un autre objet ouvre un menu contextuel. Souvent
le menu contextuel est la manière la plus rapide et la plus facile pour exécuter une fonctionnalité.
Si vous ne savez pas si une fonction se situe dans des menus ou des barres d’outils, vous pouvez
la trouver en effectuant un clic droit.

Cellules individuelles
La section principale de l’écran montre les cellules sous forme de grille, avec chaque cellule qui se
situe à l’intersection d’une colonne et d’une ligne.

Au-dessus des colonnes et  à  gauche des  lignes se trouvent  des  séries  de boîtes  grises  qui
contiennent  des  lettres  et  des  numéros.  Ce  sont  les  en-têtes  de  colonnes  et  de  lignes.  Les
colonnes commencent à  A et se poursuivent sur la droite, et les lignes commencent à  1 et se
poursuivent vers le bas.

Ces en-têtes de colonnes et de lignes forment les références de cellules qui apparaissent dans la
Zone de nom de la Barre de formule (voir Figure 2). Vous pouvez faire disparaître ces en-têtes en
sélectionnant Affichage > En-têtes de colonnes/lignes.

Onglets
En dessous de la grille des cellules se trouvent  les onglets. Ces onglets permettent  l’accès à
chaque feuille individuelle, la (les) feuille(s) visible(s) (actives) ayant un onglet blanc. Cliquer sur
un autre onglet permet d’afficher cette feuille et son onglet devient blanc. Vous pouvez également
sélectionner de multiples feuilles en une fois en gardant la touche Ctrl appuyée pendant que vous
cliquez sur les noms (voir Sélectionner des feuilles, page 21).

Vous pouvez choisir la couleur des différents onglets. Faites un clic droit sur l’onglet et choisissez
Couleur d’onglet depuis le menu déroulant pour ouvrir la palette des couleurs  (Figure 3). Pour
ajouter de nouvelles couleurs à la palette, voir “Options de couleurs” au chapitre 14, Paramétrer et
personnaliser Calc, du Guide Calc.
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Figure 3 : Choisir la couleur d’onglet

Barre d’état
La barre d’état de Calc fournit  des informations sur le classeur et des moyens pratiques pour
changer rapidement certaines de ses fonctionnalités.

Figure 4 : Côté gauche de la barre d’état

Figure 5 : Côté droit de la barre d’état

La plupart  des champs sont  similaires  à ceux des autres  composants de LibreOffice ;  voir  le
chapitre 1,  Introduction à LibreOffice dans ce livre et le chapitre 1,  Introduction à Calc dans le
Guide Calc.

Créer des classeurs

Vous pouvez démarrer un nouveau document vierge dans Calc de plusieurs façons.

• Depuis le menu du système d’exploitation, de la même manière dont vous démarrez les
autres programmes. Quand LibreOffice est installé sur votre ordinateur, dans la plupart des
cas, une entrée de menu pour chaque composant est ajoutée à votre menu système. Si
vous utilisez un Mac,  vous devriez voir  l’icône LibreOffice dans le dossier  Applications.
Quand vous double-cliquez sur cette icône, LibreOffice s’ouvre sur le Centre de démarrage
(Figure 7).

• Depuis le Démarrage rapide, que l’on peut trouver sous Windows, certaines distributions
Linux et (sous une forme légèrement différente) avec Mac OS X. Le Démarrage rapide est
une icône qui est placée dans la barre des tâches ou dans le dock au cours du démarrage
du système, à condition que l’option soit cochée dans Outils > Options > LibreOffice >
Mémoire. Elle indique que LibreOffice a été chargé et est prêt à l’emploi.

Faites un clic droit sur l’icône de Démarrage rapide (Figure 6) dans la barre des tâches
pour ouvrir un menu déroulant à partir duquel vous pouvez ouvrir un nouveau document,
ouvrir la boîte de dialogue Modèles et documents, ou choisir un document existant à ouvrir.
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Vous pouvez également double-cliquer sur l’icône de  Démarrage rapide pour afficher la
boîte de dialogue Gestionnaire de modèles.
Voyez Chapitre 1 (Présentation de LibreOffice) de ce guide pour plus d’informations sur
l’utilisation du Démarrage rapide.

Figure 6 : Menu déroulant du Démarrage rapide avec Windows Vista

• Depuis le  Centre de démarrage. Quand LibreOffice est actif, mais qu’aucun document
n’est  ouvert  (par  exemple,  si  vous fermez tous les  documents ouverts  mais  laissez le
programme en cours), le  Centre de démarrage est affiché. Cliquez sur l’une des icônes
pour ouvrir un nouveau document de ce type, ou cliquez sur l’icône Modèles pour créer un
nouveau document en utilisant un modèle.

Figure 7 : Centre de Démarrage LibreOffice

Si un document est déjà ouvert dans LibreOffice, le nouveau document s’ouvre dans une nouvelle
fenêtre.

Quand LibreOffice Calc est ouvert, vous pouvez également créer un nouveau document de l’une
des façons suivantes :
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• Appuyez sur les touches Ctrl+N.

• Utilisez Fichier > Nouveau > Classeur.

• Cliquez sur le bouton Nouveau dans la barre d’outils Standard.

Créer un nouveau document depuis un modèle
Les documents Calc peuvent également être créés depuis des modèles. Suivez les procédures ci-
dessus,  mais  au  lieu  de  choisir  Classeur,  choisissez  l’icône  Modèles depuis  le  Centre  de
démarrage ou Fichier > Nouveau > Modèles depuis la barre de menus ou la barre d’outils.

Dans  la  fenêtre  Gestionnaire  de  modèles,  sélectionnez  l’onglet  Classeurs,  naviguez  jusqu’au
dossier approprié et double-cliquez sur le modèle choisi (Figure 8). Un nouveau classeur, basé sur
le modèle sélectionné, s’ouvre.

Une nouvelle installation LibreOffice ne contient pas beaucoup de modèles, mais vous pouvez en
ajouter en les téléchargeant depuis http://templates.libreoffice.org/ et en les installant.

Voir  le  chapitre  4  du  guide  Calc (Utiliser  les  styles  et  les  modèles  dans  Calc)  pour  plus
d’informations sur les modèles.

Figure 8 : Créer un nouveau classeur depuis un modèle

Ouvrir des classeurs existants

Quand aucun document n’est  ouvert,  le  Centre de
démarrage (Figure 7) comporte une icône pour ouvrir
un  document  existant  et  la  liste  des  derniers
documents utilisés.

Vous pouvez aussi ouvrir un document existant de l’une des façons suivantes :

• Choisissez Fichier > Ouvrir.

• Cliquez sur le bouton Ouvrir dans la barre d’outils Standard.

• Appuyez Ctrl+O sur le clavier.
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• Utilisez  Fichier > Derniers documents utilisés pour afficher les 10 derniers fichiers qui
ont été ouverts par l’un des composants LibreOffice.

• Utilisez la sélection Ouvrir un document dans le Démarrage rapide.

Dans tous les cas, la boîte de dialogue Ouvrir apparaît. Sélectionnez le fichier que vous désirez,
puis cliquez sur  Ouvrir.  Si un document est déjà ouvert dans LibreOffice, le second document
s’ouvre  dans  une  nouvelle  fenêtre.  Si  vous  cochez  En  lecture  seule,  le  fichier  sera  ouvert
uniquement en lecture, la mention (lecture seule) apparaîtra à la suite du nom du fichier dans la
barre de titre et vous ne pourrez faire aucune modification.

Vous  pouvez  également  ouvrir  un  fichier  en  le  double-cliquant  depuis  l’explorateur  de  votre
système d’exploitation. Si vous avez associé les formats de fichier Microsoft Office à LibreOffice,
vous pouvez également ouvrir ces fichiers en les double-cliquant.

Ouvrir des fichiers CSV

Les fichiers Comma-Separated-Values (CSV) sont des fichiers texte qui peuvent être lus, affichés
et modifiés dans une seule feuille de calcul. Chaque ligne d’un fichier CSV représente une ligne
d’une feuille de calcul. Les virgules, les points-virgules ou d’autres caractères sont utilisés pour
séparer les cellules. Le texte peut être saisi entre des guillemets ; les nombres sont saisis sans
guillemets.

Pour ouvrir un fichier CSV dans Calc :

1) Choisissez Fichier > Ouvrir.

2) Repérez  le  fichier  CSV que  vous  voulez  ouvrir.  Vous  pouvez  sélectionner  Texte CSV
(*.csv) dans la liste déroulante  Type de fichier (descendez dans la partie tableur pour la
trouver) pour restreindre l’affichage aux fichiers ayant comme extension *.csv.

3) Sélectionnez le fichier et cliquez sur Ouvrir.

4) Dans  la  boîte  de  dialogue  Import  de  texte (Figure  9),  sélectionnez  les  Options  de
séparateur pour diviser le texte du fichier en colonnes.

5) Vous pouvez prévisualiser la mise en forme des données importées en bas de la boîte de
dialogue. Faites un clic droit  sur la colonne dans la prévisualisation pour déterminer le
format ou masquer (ne pas importer) la colonne.

Si le fichier CSV utilise un caractère de séparation de texte qui ne se trouve pas dans la
liste des Séparateurs de texte, cliquez dans la zone et saisissez le caractère.

6) Les options de la section Autres options déterminent si les données entre guillemets seront
toujours importées en tant que texte, et si Calc doit  automatiquement détecter tous les
formats numériques,  y compris les formats numériques spéciaux comme les dates,  les
heures ou la notation scientifique. La détection dépend des paramètres de langues : par
exemple en français de France, la virgule est interprétée comme séparateur décimal et le
point comme séparateur de date ; si un point est utilisé comme séparateur décimal, veillez
à modifier la Langue (par exemple Anglais (U.S.A.)). Vous pouvez modifier les formats de
date automatiquement reconnus dans la boite de dialogue Outils > Options > Paramètres
linguistiques > Langues option Motifs d’acceptation de date.

7) Cliquez sur OK pour ouvrir le fichier.
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Figure 9 : Boîte de dialogue Import de texte, avec le point-virgule et la tabulation comme 
séparateurs de colonne et le guillemet comme séparateur de texte

La méthode ci-dessus fonctionne également avec les fichiers TXT.

Attention La méthode d’ouverture des fichiers CSV est propre au module Calc. Si vous ouvrez
un fichier *.csv ou *.txt avec un autre composant de LibreOffice (Writer par exemple),
le comportement sera différent.

Fermer les classeurs

Pour fermer un classeur, vous pouvez cliquer la croix en haut à droite de la fenêtre ou choisir
Fichier > Fermer dans la barre de menus. S’il existe des modifications non encore enregistrées
dans  votre  classeur,  un  message  apparaîtra,  vous  demandant  si  vous  voulez  enregistrer  le
classeur, le fermer sans enregistrer ou annuler et revenir dans le classeur.

Si vous voulez quitter LibreOffice, vous pouvez choisir Fichier > Quitter LibreOffice dans la barre
de  menus,  ou  appuyer  sur  les  touches  Ctrl+Q.  Chaque  document  sera  fermé,  ainsi  que
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l’application  LibreOffice.  Un  message  apparaîtra  pour  chaque  document  comportant  des
modifications non enregistrées.

Enregistrer les classeurs

Les classeurs peuvent être enregistrés de trois manières :

• Appuyez sur Ctrl+S.

• Choisissez Fichier > Enregistrer (ou Tout enregistrer ou Enregistrer sous).

• Cliquez sur le bouton Enregistrer de la barre d’outils Standard.

Si le classeur n’a pas encore été sauvegardé précédemment, alors chacune de ces actions ouvrira
la  boîte  de  dialogue  Enregistrer  sous.  Vous  pourrez  alors  spécifier  le  nom  du  classeur  et
l’emplacement du stockage.

Note

Si le classeur a été enregistré précédemment, alors l’enregistrer en utilisant la 
commande Enregistrer (ou Tout enregistrer) va écraser la version existante. 
Toutefois, vous pouvez enregistrer le classeur à un emplacement différent ou avec 
un nom différent en sélectionnant Fichier > Enregistrer sous.

Enregistrer en tant que document Microsoft Excel
Certains utilisateurs de Microsoft Excel peuvent ne pas souhaiter ou être incapables de recevoir
des fichiers *.ods. Dans ce cas, vous pouvez enregistrer un document en tant que fichier Excel
(*.xls ou *.xlsx).

1) Important – Enregistrez tout d’abord votre classeur dans le format de fichier utilisé par
LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu
effectuer depuis le moment de votre dernier enregistrement apparaîtront uniquement dans
la version Microsoft Excel du document.

2) Puis choisissez Fichier > Enregistrer sous.

3) Dans la boîte de dialogue Enregistrer sous (Figure 10), dans le menu déroulant  Type de
fichier,  sélectionnez  le  type  de  format  Excel  dont  vous  avez  besoin.  Cliquez  sur
Enregistrer.
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Figure 10 : Enregistrer un classeur au format Microsoft Excel

4) Il est possible que le message de la Figure 11 apparaisse. Cliquez sur Utiliser le format
Microsoft Excel … correspondant au format que vous avez choisi.

Figure 11 : Message de confirmation lors de l’enregistrement dans un format autre qu’ODF

Attention À partir de ce moment, toutes les modifications que vous apporterez au classeur 
auront lieu uniquement dans le document Microsoft Excel. Vous avez changé le nom
et le type de fichier de votre document. Si vous voulez revenir en arrière pour 
travailler avec la version *.ods de votre classeur, vous devez l’ouvrir à nouveau.
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Enregistrer en tant que fichier CSV
Dans un fichier CSV, vous ne pouvez enregistrer que la feuille courante du classeur.  De même
vous ne pouvez enregistrer que les valeurs (numérique ou texte) de chaque cellule : vous perdrez
le formatage, ainsi que les objets insérés (image, diagramme, etc.). Pour enregistrer une feuille en
tant que fichier CSV :

1) Choisissez Fichier > Enregistrer sous.

2) Dans le champ Nom du fichier, tapez le nom du fichier.

3) Dans la liste Type de fichier, sélectionnez Texte CSV (*.csv) et cliquez sur Enregistrer. Il
est possible que le message  de la  Figure 12 apparaisse. Cliquez sur  Utiliser le format
Texte CSV.

Figure 12 : Message de confirmation lors de l’enregistrement en format CSV

4) Dans la boîte de dialogue Export de fichier texte, sélectionnez les options que vous voulez
et cliquez ensuite sur OK.

Figure 13 : Choix des options lors de l’export en Texte CSV

Enregistrement dans d’autres formats
Calc peut  enregistrer  des classeurs dans une variété de formats,  dont  HTML (pages Web),  à
travers la boîte de dialogue Enregistrer sous. Calc peut également exporter des classeurs vers les
formats de fichier PDF et XHTML. Voir le chapitre 6 du Guide Calc (Imprimer, exporter et envoyer
par e-mail).

Naviguer dans les classeurs

Calc propose plusieurs façons de naviguer à l’intérieur d’un classeur, de cellule à cellule et de
feuille à feuille. Vous pouvez en général utiliser la méthode que vous préférez.
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Aller vers une cellule particulière

Utiliser la souris
Placez le pointeur de la souris sur la cellule et cliquez.

Utiliser une référence de cellule
Cliquez sur le petit triangle noir renversé situé juste à droite de la Zone de nom (Figure 2, page
7). La référence de cellule actuelle sera en surbrillance. Tapez la référence de la cellule où
vous voulez  aller  et  appuyez sur  Entrée.  Les  références de cellules  sont  insensibles  à  la
casse : a3 ou A3, par exemple, sont identiques. Ou cliquez simplement dans la Zone de nom,
faites un retour arrière sur la référence de cellule existante, tapez la référence de cellule que
vous voulez et appuyez sur Entrée.

Utiliser le Navigateur
Cliquez sur  le  bouton  Navigateur de la  barre d’outils  Standard (ou appuyez sur  F5)  pour
afficher le Navigateur. Tapez la référence de cellule dans les deux champs du haut, intitulés
Colonne et Ligne, et appuyez sur  Entrée. Dans la  Figure 14, le Navigateur sélectionnera la
cellule B4. Pour plus d’informations sur l’utilisation du Navigateur, le chapitre 1, Introduction à
Calc, du Guide Calc.

Figure 14 : Le Navigateur de Calc

Se déplacer de cellule à cellule
Dans le classeur, une des cellules a normalement une bordure noire plus épaisse. Cette bordure
noire indique où se trouve le focus (voir Figure 15). Le focus indique quelle cellule est activée pour
recevoir une entrée. Si un groupe de cellules est sélectionné, elles ont une couleur de surbrillance
(habituellement bleu), avec la cellule du focus qui a une bordure sombre.

Naviguer dans les classeurs 17



Figure 15 : Une cellule avec focus (gauche) et un groupe de cellules sélectionnées (droite)

Utiliser la souris
Pour déplacer le focus en utilisant la souris, déplacez simplement le pointeur de la souris sur la
cellule où vous voulez le focus et  cliquez sur le bouton gauche de la  souris.  Cette action
déplace le  focus vers  la  nouvelle  cellule.  Cette  méthode  est  la  plus  utile  quand les  deux
cellules sont éloignées.

Utiliser les touches Tab et Entrée
• Appuyer  sur  Entrée ou  Maj+Entrée déplace  le  focus  vers  le  bas  ou  vers  le  haut,

respectivement.

• Appuyer  sur  Tab ou  Maj+Tab déplace  le  focus  vers  la  droite  ou  vers  la  gauche,
respectivement.

Utiliser les touches flèches
Appuyer sur les touches flèches du clavier déplace le focus dans la direction des flèches.

Utiliser Début, Fin, Page précédente et Page suivante
• Début ( )↖  déplace le focus au début d’une ligne.

• Fin déplace le focus vers la colonne la plus à droite qui contient une donnée.

• Page  suivante  (PgSuiv) déplace  l’affichage  d’un  écran  complet  vers  le  bas  et  Page
précédente (PgPrec) déplace l’affichage d’un écran complet vers le haut.

• Les combinaisons de  Contrôle (souvent représentée sur les claviers par  Ctrl) et  Alt avec
Début,  Fin,  Page précédente,  Page suivante et  les touches flèches déplacent  le  focus
depuis  la  cellule  courante  de  manières  différentes.  Le  Tableau  1 décrit  les  raccourcis
clavier pour se déplacer dans un classeur.

Astuce Utilisez Alt+→ ou Alt+← pour augmenter ou diminuer la largeur d’une cellule.

Tableau 1 : Se déplacer de cellule à cellule en utilisant le clavier

Combinaison de 
touches

Mouvement

→ Une cellule sur la droite

← Une cellule sur la gauche

↑ Une cellule vers le haut

↓ Une cellule vers le bas
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Combinaison de 
touches

Mouvement

Ctrl+→ Vers la colonne suivante sur la droite contenant une donnée sur cette 
ligne ou vers la dernière colonne AMJ

Ctrl+← Vers la colonne suivante sur la gauche contenant une donnée sur cette 
ligne ou vers la colonne A

Ctrl+↑ Vers la ligne suivante vers le haut contenant une donnée dans cette 
colonne ou vers la ligne 1

Ctrl+↓ Vers la ligne suivante vers le bas contenant une donnée dans cette 
colonne ou vers la dernière ligne 1 048 576

Ctrl+↖ Vers la cellule A1

Ctrl+Fin Vers le coin inférieur droit de la zone rectangulaire qui contient des 
données

Alt+PgSuiv Un écran sur la droite (si possible)

Alt+PgPrec Un écran sur la gauche (si possible)

Ctrl+PgSuiv Une feuille sur la droite (dans les onglets)

Ctrl+PgPrec Une feuille sur la gauche (dans les onglets)

Tab Vers la prochaine cellule sur la droite

Maj+Tab Vers la prochaine cellule sur la gauche

Entrée Une cellule vers le bas (sauf changement par l’utilisateur)

Maj+Entrée Une cellule vers le haut (sauf changement par l’utilisateur)

Se déplacer de feuille à feuille
Chaque feuille dans un classeur est indépendante des autres, bien qu’elles puissent être liées par
des références d’une feuille à l’autre. Il y a trois façons de naviguer entre les différentes feuilles
d’un classeur.

Utiliser le clavier
Appuyer sur Ctrl+Page suivante permet de se déplacer d’une feuille vers la droite et appuyer
sur Ctrl+Page précédente permet de se déplacer d’une feuille vers la gauche.

Utiliser la souris
Cliquer  sur  un  des  onglets  en  bas  du  classeur  permet  de  sélectionner  la  feuille
correspondante.

Si vous avez beaucoup de feuilles, certains des onglets peuvent alors être cachés derrière la
barre de défilement horizontal en bas de l’écran. Si c’est le cas, les quatre boutons à la gauche
des onglets peuvent alors faire apparaître les onglets cachés. La Figure 16 montre comment le
faire.

Note
Les flèches des onglets qui apparaissent Figure 16 apparaissent seulement si vous 
avez des onglets qui ne sont pas visibles. Sinon, elles apparaissent en grisé comme 
sur la Figure 1 page 6.
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Figure 16 : Flèches de tabulation des feuilles

Utiliser le navigateur
Dans le navigateur (Figure 14, page17), cliquez sur le symbole + à côté de Feuilles pour voir la
liste des feuilles du classeur. Double-cliquez sur la feuille à atteindre.

Notez que les feuilles  ne sont  pas  numérotées dans l’ordre.  La numérotation des feuilles  est
arbitraire ; vous pouvez nommer une feuille comme vous le voulez. La barre d’état de la Figure 16
indique que Feuille7 est en quatrième position parmi les sept feuilles du classeur.

Sélectionner des éléments dans une feuille ou un classeur

Sélectionner des cellules
Les cellules peuvent être sélectionnées dans une variété de combinaisons et de quantités.

Cellule individuelle
Pour sélectionner une cellule individuelle, celle-ci doit avoir le focus, comme indiqué page 17. Le
résultat ressemblera à la partie gauche de la Figure 15 page 18. Vous pouvez vérifier en regardant
dans  la  Zone  de  nom.  Faites  ensuite  un  Ctrl+Clic  gauche dans  la  cellule  qui  sera  mise  en
surbrillance.

Plage de cellules contiguës
Une plage de cellules peut être sélectionnée en utilisant le clavier ou la souris.

Pour sélectionner une plage de cellules en faisant glisser la souris :

1) Cliquez dans une cellule.

2) Appuyez et gardez appuyé le bouton gauche de la souris.

3) Déplacez la souris sur l’écran.

4) Une fois que le bloc de cellules souhaité est en surbrillance, relâchez le bouton gauche de
la souris.

Pour sélectionner une plage de cellules sans faire glisser la souris :

1) Cliquez dans la cellule qui sera un des coins de la plage de cellules.

2) Déplacez la souris dans le coin opposé de la plage de cellules.

3) Gardez appuyée la touche Maj et cliquez.

Pour sélectionner une plage de cellules sans utiliser la souris :

1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.

2) En gardant appuyée la touche Maj, utilisez les flèches du curseur pour sélectionner le reste
de la plage.

Le résultat de l’une de ces méthodes ressemblera au côté droit de la Figure 15.
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Astuce

Vous pouvez également sélectionner directement une plage de cellules en utilisant 
la Zone de nom. Cliquez dans la Zone de nom comme décrit dans “Utiliser une 
référence de cellule” page 17. Pour sélectionner une plage de cellules, saisissez la 
référence de cellule du coin supérieur gauche, suivi de deux points (:), et ensuite de 
la référence de cellule du coin inférieur droit. Par exemple, pour sélectionner la 
plage qui va de A3 à C6, vous saisiriez A3:C6.

Plage de cellules non contiguës
1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.

2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.

3) Gardez appuyée la touche Ctrl et cliquez ou cliquez et faites glisser pour sélectionner une
autre plage de cellules à ajouter à la première plage.

4) Répétez autant que nécessaire.

Sélectionner des colonnes et les lignes
Les colonnes et les lignes entières peuvent être sélectionnées très rapidement dans LibreOffice.

Colonne ou ligne individuelle
Pour sélectionner une colonne individuelle, cliquez sur la lettre identifiant la colonne (voir Figure 2
page 7) ou utilisez le raccourci-clavier Ctrl+Maj+Espace.

Pour sélectionner une ligne individuelle,  cliquez sur le numéro identifiant la ligne  ou utilisez le
raccourci-clavier Maj+Espace .

Colonnes ou lignes multiples
Pour sélectionner des colonnes ou lignes multiples qui sont contiguës :

1) Cliquez sur la première colonne ou ligne du groupe.

2) Gardez appuyée la touche Maj.

3) Cliquez sur la dernière colonne ou ligne du groupe.

Pour sélectionner des colonnes ou lignes multiples qui ne sont pas contiguës :

1) Cliquez sur la première colonne ou ligne du groupe.

2) Gardez appuyée la touche Ctrl.

3) Cliquez sur toutes les colonnes ou lignes suivantes en gardant appuyée la touche Ctrl.

Feuille entière
Pour sélectionner la feuille entière, cliquez dans la petite boîte entre l’en-tête de colonne A et l’en-
tête de ligne 1. Vous pouvez également appuyer sur Ctrl+A pour sélectionner la feuille entière.

Figure 17 : Boîte Tout sélectionner

Sélectionner des feuilles
Vous  pouvez  sélectionner  une  ou  plusieurs  feuilles.  Il  peut  être  intéressant  de  sélectionner
plusieurs feuilles en même temps si vous voulez effectuer des modifications dans plusieurs feuilles
en une seule fois.
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Feuille individuelle
Cliquez sur l’onglet de la feuille que vous voulez sélectionner. L’onglet de la feuille active devient
blanc (voir Figure 16 page 20).

Plusieurs feuilles contiguës
Pour sélectionner plusieurs feuilles contiguës :

1) Cliquez sur l’onglet de la première feuille désirée.

2) Déplacez le pointeur de la souris sur l’onglet de la dernière feuille désirée.

3) Gardez appuyée la touche Maj et cliquez sur l’onglet.

Tous les onglets entre ces deux feuilles deviennent blancs. Toute action que vous ferez affectera
désormais toutes les feuilles en surbrillance.

Plusieurs feuilles non contiguës
Pour sélectionner plusieurs feuilles non contiguës :

1) Cliquez sur l’onglet de la première feuille désirée.

2) Déplacez le pointeur de la souris sur l’onglet de la deuxième feuille désirée.

3) Gardez appuyée la touche Ctrl et cliquez sur l’onglet.

4) Répétez autant que nécessaire.

Les  onglets  sélectionnés  deviennent  blancs.  Toute  action  que  vous ferez  affectera  désormais
toutes les feuilles en surbrillance.

Toutes les feuilles
Faites un clic droit sur l’un des onglets et choisissez  Sélectionner toutes les feuilles dans le
menu déroulant.

Pour désélectionner
Pour revenir au fonctionnement par défaut avec une seule feuille sélectionnée, il suffit de cliquer
sur  l’onglet  d’une  feuille  non  sélectionnée.  Si  toutes  les  feuilles  sont  sélectionnées,  faites  un
Ctrl+clic sur un des onglets.

Note
Si une couleur d’onglet a été définie pour une feuille, lorsque cette feuille est 
sélectionnée, la couleur n’apparaît qu’en bas de l’onglet et le reste de la zone 
devient blanc.

Attention Une fois les modifications effectuées sur les différentes feuilles, pensez à revenir à
une seule feuille sélectionnée, sinon vos modifications continueront à s’appliquer à
toutes les feuilles. Pour cela, cliquez sur l’onglet d’une feuille non sélectionnée.

Actions sur les colonnes et les lignes

Insérer des colonnes et des lignes
Les colonnes et les lignes peuvent être insérées individuellement ou en groupes.
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Note

Quand vous insérez une colonne individuelle, elle est insérée à la gauche de la 
colonne en surbrillance. Quand vous insérez une ligne individuelle, elle est insérée
au-dessus de la ligne en surbrillance.

Les cellules des nouvelles colonnes ou lignes sont formatées comme les cellules 
correspondantes de la colonne ou de la ligne avant (ou à gauche de) la nouvelle 
colonne ou ligne insérée.

Colonne ou ligne individuelle
Utiliser le menu Insertion :

1) Sélectionnez la cellule, colonne ou ligne où vous voulez insérer la nouvelle colonne ou
ligne.

2) Choisissez Insertion > Colonnes ou Insertion > Lignes.

Utiliser la souris :

1) Sélectionnez la cellule, colonne ou ligne où vous voulez insérer la nouvelle colonne ou
ligne.

2) Faites un clic droit sur l’en-tête de colonne ou de ligne.

3) Choisissez Insérer des lignes ou Insérer des colonnes.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent être insérées en une fois plutôt qu'une par une.

1) Mettez en surbrillance le nombre voulu de colonnes et de lignes en gardant appuyé le
bouton gauche de la souris sur la première et ensuite en le faisant glisser sur le nombre
voulu d’identifiants.

2) Procédez comme pour insérer une seule colonne ou ligne comme ci-dessus.

Supprimer des colonnes et des lignes
Les colonnes et les lignes peuvent être supprimées individuellement ou par groupes.

Colonne ou ligne individuelle
Une colonne ou ligne individuelle peut être supprimée en utilisant la souris :

1) Sélectionnez la colonne ou la ligne à supprimer.

2) Choisissez Édition > Supprimer des cellules depuis la barre de menus.

Ou,

1) Faites un clic droit sur l’en-tête de la colonne ou de la ligne.

2) Choisissez Supprimer des colonnes ou Supprimer des lignes dans le menu déroulant.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent être supprimées en une fois plutôt qu'une par une.

1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes en gardant appuyé le
bouton gauche de la souris sur la première et ensuite en le faisant glisser sur le nombre
voulu d’identifiants.

2) Procédez comme pour supprimer une seule colonne ou ligne comme ci-dessus.

Astuce
Au lieu de supprimer une ligne ou une colonne, vous pouvez souhaiter supprimer 
les contenus des cellules, mais garder la ligne ou la colonne vide. Voir le chapitre 
2 du guide Calc (Saisir, modifier et formater les données) pour instructions.
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Actions sur les feuilles

Comme tous  les  autres  éléments  de  Calc,  les  feuilles  peuvent  être  insérées,  supprimées  et
renommées.

Insérer de nouvelles feuilles
Il y a plusieurs façons d’insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le
bouton Ajouter une feuille . Elle insère une nouvelle feuille à cet endroit, sans ouvrir la boîte
de dialogue Insérer une feuille.

Utilisez l’une des autres méthodes pour insérer plus d’une feuille, pour renommer en même temps
la feuille ou pour insérer la feuille ailleurs dans la séquence. La première étape pour toutes ces
méthodes est de sélectionner les feuilles près desquelles la nouvelle feuille va être insérée. Puis
utilisez l’une des options suivantes.

• Choisissez Insertion > Feuille depuis la barre de menus.

• Faites un clic droit sur l’onglet et choisissez Insérer une feuille.

• Cliquez sur un espace vide à la fin de la ligne des onglets.

Figure 18 : Créer une nouvelle feuille

Chaque méthode ouvrira une boîte de dialogue Insérer une feuille (Figure 19). Là, vous pouvez
déterminer  si  la  nouvelle  feuille  sera  positionnée  avant  ou  après  la  feuille  sélectionnée  et  le
nombre  de  feuilles  que  vous  voulez  insérer.  Si  vous  insérez  une  seule  feuille,  vous  avez  la
possibilité ici de lui donner un nom.

Figure 19 : Boîte de dialogue Insérer une feuille

Astuce
Vous pouvez fixer le nombre de feuilles des nouveaux documents en sélectionnant
Outils > Options > LibreOffice Calc > Par défaut. Par défaut, une seule feuille 
de calcul est créée lors de la création d’un nouveau document.
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Renommer des feuilles
Le nom par défaut d’une nouvelle feuille est  aaaX,  où  aaa est le préfixe défini dans  Outils >
Options > LibreOffice Calc > Par défaut (Feuille par défaut) et X est un numéro. Si cela convient
pour un petit classeur avec seulement quelques feuilles, cela devient moins lisible lorsqu’il y en a
beaucoup. Pour donner à une feuille un nom plus significatif, vous pouvez :

• saisir le nom dans la Zone de nom quand vous créez la feuille ;

• faire un clic droit  sur l’onglet et  choisir  Renommer la feuille dans le menu déroulant ;
remplacer le nom existant par un nouveau.

• faire Alt+Clic sur l’onglet pour y modifier directement le nom ;

• double-cliquer sur l’onglet pour ouvrir la boîte de dialogue Renommer la feuille.

Note

Les noms de feuilles peuvent contenir presque n’importe quel caractère hormis 
quelques caractères spéciaux (entre autres \ / :? * [ ]). Certaines restrictions de 
nom s’appliquent lorsque vous souhaitez enregistrer le classeur au format 
Microsoft Excel. Une tentative de renommer une feuille avec un nom incorrect 
produira un message d’erreur.

Déplacer et copier des feuilles
Sélectionnez tout d’abord la feuille que vous voulez déplacer ou copier. Vous pouvez ensuite soit
faire un clic droit sur l’onglet de la feuille et choisir Déplacer/Copier la feuille, soit choisir Édition
> Feuille > Déplacer/copier depuis la barre de menus. La boîte de dialogue Déplacer/copier la
feuille apparaît (Figure 20).

Figure 20 : Boîte de dialogue Déplacer/copier la feuille

Action
Choisissez la case à cocher pour déplacer la feuille sélectionnée ou pour créer une nouvelle
feuille en copiant la feuille sélectionnée.
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Vers le document
Permet de déplacer ou copier la feuille sélectionnée à l’intérieur du document (classeur) actif,
vers un autre document ouvert dans LibreOffice, ou vers un nouveau document.

Insérer avant
Permet d’indiquer, dans le classeur de destination, avant quelle feuille la feuille sélectionnée
doit être déplacée ou copiée.

Nouveau nom
Permet de renommer la feuille déplacée ou créée par copie.

Attention
Si vous choisissez comme document de destination un autre classeur ouvert ou 
- nouveau document -, cela peut créer des conflits pour les formules liées à 
d’autres feuilles du document d’origine. Si vous déplacez involontairement une 
feuille, vous pouvez y remédier en déplaçant ou copiant la feuille à son 
emplacement d’origine.

Vous pouvez également déplacer une feuille à l’intérieur d’un classeur en cliquant sur son onglet et
en le faisant glisser vers son emplacement de destination. Deux petits triangles (voir  Figure 21)
indiquent l’endroit où la feuille sera déplacée. Le pointeur de la souris peut se transformer en un
symbole  d’indication ;  ceci  dépend  de  votre  système  d’exploitation.  Pour  copier  une  feuille  à
l’intérieur d’un classeur, procédez de la même façon tout en gardant la touche Ctrl appuyée.

Figure 21 : Faire glisser une feuille pour la déplacer

Supprimer des feuilles
Les feuilles peuvent être supprimées individuellement ou par groupes.

Feuille individuelle
Faites un clic droit sur l’onglet que vous voulez supprimer et choisissez Supprimer la feuille
dans le  menu contextuel,  ou  choisissez  Édition > Feuille  >  Supprimer dans la  barre de
menus. Dans tous les cas, un avertissement vous demandera si  vous voulez supprimer la
feuille définitivement. Cliquez sur Oui.

Feuilles multiples
Pour supprimer des feuilles multiples, sélectionnez-les comme décrit auparavant  (page  21),
puis soit faites un clic droit sur l’un des onglets et choisissez  Supprimer la feuille dans le
menu contextuel, ou choisissez Édition > Feuille > Supprimer dans la barre de menus.

Affichage de Calc

Utiliser le zoom
Utilisez le zoom pour changer l’affichage afin de montrer plus ou moins de cellules dans la fenêtre.

En plus de l’utilisation du curseur de zoom dans la barre d’état, vous pouvez ouvrir la boîte de
dialogue Zoom & disposition des pages et modifier le facteur de zoom.

• Choisissez Affichage > Zoom dans la barre de menus, ou

• Double-cliquez sur le pourcentage dans la barre d’état en bas de la fenêtre.
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Figure 22 : Boîte de dialogue Zoom & disposition des pages

Optimal
Redimensionne l’affichage pour correspondre à la taille de la plage des cellules sélectionnées.
Pour utiliser cette option, vous devez tout d’abord mettre en surbrillance une plage de cellules.

Adapter la largeur et la hauteur
Affiche la page entière sur votre écran.

Adapter à la largeur
Affiche la largeur complète de la page du document. Les bords supérieur et inférieur de la
page peuvent ne pas être visibles.

100 %
Affiche le document à sa taille initiale.

Variable
Entrez le pourcentage de zoom de votre choix.

Scinder l’écran ou fixer les lignes et colonnes
Une autre façon de changer l’affichage est de scinder la fenêtre, ou écran. L’écran peut être scindé
horizontalement,  verticalement,  ou les deux. Vous pouvez par conséquent avoir jusqu’à quatre
portions de la feuille à l’affichage en même temps comme sur la Figure 23.

Pourquoi  vouloir  le  faire ? Un exemple serait  un grand classeur  dans lequel  une des cellules
contient un nombre qui est utilisé par trois formules dans d’autres cellules. En scindant l’écran,
vous pouvez positionner la cellule contenant le nombre dans une section et chacune des cellules
avec formule dans les autres sections. Vous pouvez alors changer le nombre dans la cellule et voir
comment cela affecte chacune des formules.

Le moyen le plus simple de scinder l’écran en utilisant une commande de menu,  est de cliquer
dans la cellule juste en dessous et juste à droite de l’endroit où vous souhaitez scinder l’écran, et
de sélectionner le menu Fenêtre > Scinder.

À la place de scinder l’écran, il est également  possible de fixer les lignes ou les colonnes dans
cette configuration. La procédure est  la même que précédemment, mais il  faut  sélectionner la
commande Fenêtre > Fixer.

Pour  plus  d’informations  sur  ces  commandes  de  modification  de l’affichage,  reportez-vous  au
chapitre 1, Introduction à Calc, du Guide Calc.
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Figure 23 : Exemple d’écran scindé

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres
Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie
principale du clavier, soit du pavé numérique.

Pour entrer un nombre négatif, tapez le signe moins (–) devant lui.  Le signe plus (+) n'est pas
nécessaire pour les nombres positifs.

Par défaut, les nombres sont alignés à droite et les nombres négatifs commencent par le signe
moins.

Saisir des textes
Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur l’icône Étendre la barre Formule . La

zone de saisie devient alors multilignes (Figure 24). Cliquez à nouveau sur l’icône  pour revenir
à la zone de saisie initiale.
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Figure 24 : Zone de saisie multi-lignes

Saisir des nombres en tant que textes
Si un nombre est saisi dans le format 01481, Calc supprimera le 0 devant ce nombre. (Exception :
voir  l’Astuce  ci-dessous.)  Pour  conserver  le  0  de  devant,  par  exemple  pour  un  numéro  de
téléphone, vous pouvez soit :

• assigner le format texte à la cellule (Format > Cellules > Nombres et choisir la catégorie
Texte) et taper ensuite le nombre, comme ceci : 01481 ;

• taper une apostrophe (guillemet simple) devant le nombre, comme ceci : ’01481. 

La donnée est désormais traitée comme un texte et est affichée exactement comme elle a été
saisie. Par conséquent, les formules considéreront cette saisie comme un zéro et les fonctions
l’ignoreront.

Astuce

Les nombres peuvent commencer par des zéros et être toujours considérés 
comme des nombres (et non comme des textes) si la cellule est formatée de façon
appropriée. Faites un clic droit dans la cellule et choisissez Formater les cellules 
> Nombres. Ajustez le paramétrage Zéros non significatifs pour ajouter des zéros 
au début des nombres.

Note

Quand une apostrophe est utilisée pour permettre l’affichage d’un 0 au début d’un 
nombre, elle n’est pas visible dans la cellule dès lors que la touche Entrée est 
appuyée. Si des “guillemets intelligents” sont utilisés comme apostrophes, 
l’apostrophe restera visible dans la cellule.

Pour choisir ce type d’apostrophe, utilisez Outils > Options d’AutoCorrection > 
Options linguistiques. Cochez Remplacer les guillemets simples pour activer 
cette fonction. La sélection du type de guillemet simple s’appliquera à la fois à 
Calc et à Writer.

Attention Quand un nombre est formaté en tant que texte, prenez garde à ce que la cellule 
contenant ce nombre ne soit pas utilisée dans une formule, parce que Calc 
ignorera sa valeur.

Saisir des dates et des heures
Sélectionnez la cellule et tapez la date ou l’heure. Vous pouvez séparer les éléments de la date
avec un slash (/) ou un tiret (–) ou utiliser un texte comme 10 octobre 03. Calc reconnaît plusieurs
formats  de  date.  Vous  pouvez  séparer  les  éléments  de  temps  avec  des  deux-points  comme
10:43:45.
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Les formats de dates reconnus par Calc peuvent être définis dans l’option Motifs d’acceptation de
date dans  Outils  >  Options  >  Paramètres  linguistiques  >  Langues,  avec  les  notations
suivantes : D pour le jour, M pour le mois et Y pour l’année.

Astuce

Les raccourcis clavier Ctrl+; et Maj+Ctrl+; permettent d’entrer la date et l’heure 
courante dans la cellule, respectivement formatées en date et en heure. L’entrée 
est effectuée sous forme de valeur. N’étant pas des fonctions ou des champs, les 
données ne sont pas actualisées par la suite.

Désactiver les changements automatiques
Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que
vous n’ayez désactivé ces changements. Vous pouvez également annuler immédiatement chaque
changement automatique avec Ctrl+Z.

Changements de l’AutoCorrection
La correction automatique des erreurs de frappe,  le  remplacement  des guillemets doubles
droits par des apostrophes courbes et le début de contenu de cellule avec une lettre majuscule
sont  contrôlés par  Outils > Options d’AutoCorrection.  Allez dans les onglets  Options ou
Remplacer pour désactiver chaque caractéristique indésirable. Dans l’onglet Remplacer, vous
pouvez également supprimer les paires de mots non souhaitées et ajouter de nouvelles paires.

AutoSaisie
Quand vous tapez du texte dans une cellule, Calc suggère automatiquement une occurrence
trouvée dans la même colonne. Pour activer ou désactiver l’AutoSaisie, affichez ou enlevez
une coche devant Outils > Contenu des cellules > AutoSaisie.

Conversion automatique des dates
Calc convertit automatiquement certaines saisies en dates. Pour s’assurer qu’une saisie qui
ressemble à une date  est considérée comme un texte, formatez la cellule en texte ou tapez
une apostrophe au début de la saisie.

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail,  mais Calc fournit
plusieurs outils pour alléger certaines corvées de saisie.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d’une cellule dans une
autre avec la souris. Beaucoup de personnes trouvent également utile l’AutoSaisie. Calc recèle
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les tâches
répétitives. Ce sont l’outil Remplir, les listes de sélection et la possibilité de saisir de l’information
dans plusieurs feuilles du document.

Utiliser l’outil Remplir dans les cellules
Au plus simple, l’outil  Remplir est une façon de dupliquer un contenu existant. Commencez par
sélectionner la cellule à copier, puis faites glisser la souris dans une direction (ou gardez appuyée
la touche  Maj et cliquez dans la dernière cellule que vous voulez remplir), et choisissez ensuite
Édition > Remplir et la direction dans laquelle vous voulez effectuer la copie : Haut, Bas, Gauche
ou Droite (Figure 25).
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Attention Les choix qui ne sont pas valables sont grisés, mais vous pouvez toujours choisir 
la direction opposée à celle que vous souhaitez, ce qui peut avoir comme 
conséquence d’écraser accidentellement des cellules.

Figure 25 : Utiliser l’outil Remplir

Utiliser la poignée de recopie
La poignée de recopie est le petit carré noir dans le coin inférieur droit de la cellule active. Si vous
souhaitez simplement recopier un texte, comme dans le cas de la Figure 25, cliquez dans la cellule
contenant le texte à recopier, puis cliquez-glissez la poignée dans la direction où vous souhaitez
recopier le texte. Une seule direction peut être réalisée à la fois. Si vous souhaitez une matrice de
texte, il faut vous y reprendre à deux fois.

Si la cellule contient une valeur numérique, alors la valeur est incrémentée si on tire la poignée
vers la droite ou le bas, et décrémentée si on tire la poignée vers la gauche ou le haut. Si vous ne
souhaitez pas que la valeur soit modifiée, maintenez la touche Ctrl enfoncée au moment où vous
relâchez la souris.

Dans  un  texte  contenant  une  valeur  numérique  en  fin  de  chaîne,  celle-ci  est  reconnue  et
incrémentée/décrémentée avec la poignée de recopie, sauf si elle est combinée avec la touche
Ctrl.

Utiliser les listes de sélection
Les listes de sélection sont disponibles uniquement pour les textes et sont
limitées à l’usage de textes qui ont été déjà saisis dans la même colonne.

Pour utiliser une liste de sélection, sélectionnez une cellule vide et appuyez
sur  Alt+↓ (flèche bas) (versions précédentes :  Ctrl+D ou  Ctrl+Maj+D),  ou
faites un clic droit  et choisissez  Liste de sélection.  Une liste déroulante
apparaît, contenant toutes les cellules de la même colonne qui ont au moins
un caractère de texte ou dont le format est défini comme texte. Les textes
des  cellules  sont  triés  par  ordre  alphabétique  et  ceux  qui  ont  des
occurrences multiples n’apparaissent qu’une seule fois. Cliquez sur l’entrée
dont vous avez besoin.
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Partager du contenu entre différentes feuilles
Vous pouvez vouloir entrer la même information dans la même cellule de plusieurs feuilles, par
exemple pour fixer des listes standard pour un groupe de personnes ou pour des organismes. Au
lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une fois pour
toutes  les  feuilles.  Pour  ce  faire,  sélectionnez  les  feuilles  désirées  (Édition  >  Feuille  >
Sélectionner et cliquez sur le nom des feuilles désirées en maintenant la touche Ctrl enfoncée),
puis saisissez l’information dans la feuille courante.

Attention Cette technique écrase toute information qui se trouve déjà dans les cellules des 
autres feuilles, sans aucun avertissement. Pour cette raison, quand vous avez fini,
assurez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez 
modifier. (Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Valider le contenu des cellules

Quand vous créez des classeurs pour que d’autres personnes les utilisent, vous pouvez vouloir
vous assurer qu’elles saisissent des données qui sont valides ou appropriées pour la cellule. Vous
pouvez également  utiliser  la  validation  pour  votre propre  usage comme guide pour  saisir  des
données complexes ou rarement utilisées.

Les séries  de remplissage  et  les  listes  de sélection  peuvent  convenir  pour  certains  types de
données, mais elles sont limitées aux informations prédéfinies. Pour valider une nouvelle donnée
saisie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité pour définir le type
de contenu qui peut être saisi dans cette cellule. Par exemple, une cellule peut nécessiter une date
ou un nombre entier, sans caractère alphabétique ni point décimal ; ou bien encore une cellule ne
doit pas être laissée vide.

Selon le paramétrage de la validation, l’outil peut aussi définir l’intervalle des valeurs qui peuvent
être saisies, et fournir des messages d’aide qui expliquent les règles de validation que vous avez
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s’ils saisissent un contenu
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l’accepter
avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une erreur est saisie.

Pour plus d’informations sur cette fonctionnalité, voir le chapitre 2,  Saisir, éditer et formater des
données dans le Guide Calc.

Modifier les données

La modification des données se fait en gros de la même manière que leur saisie. La première
étape est de sélectionner la cellule contenant les données à modifier.

Supprimer les données d’une cellule
Les données d’une cellule peuvent être effacées (supprimées) de plusieurs façons.

Supprimer les données seulement
Les données seules peuvent être supprimées dans une cellule sans affecter le formatage de la
cellule. Cliquez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent être supprimés d’une cellule en une seule fois. Appuyez
sur la touche Retour arrière (ou faites un clic droit et choisissez Supprimer du contenu, ou
utilisez  Édition >  Supprimer du contenu)  pour  ouvrir  la  boîte de dialogue Supprimer  du
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contenu (Figure 26). Dans cette boîte de dialogue, plusieurs attributs de la cellule peuvent être
supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez Tout supprimer.

Figure 26 : Boîte de dialogue Supprimer du 
contenu

Note
Si vous choisissez Héritage OpenOffice.org comme Raccourci clavier dans l’option
Outils > Options > LibreOffice Calc > Compatibilité, le comportement des 
touches Suppr et Retour arrière est inversé.

Remplacer toutes les données dans une cellule
Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les
anciennes données. Les nouvelles données conserveront le format d’origine.

Changer une partie des données dans une cellule
Il est parfois nécessaire de changer le contenu d’une cellule sans en supprimer tout le contenu,
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en
“Jean va partir demain.” Il est souvent utile de le faire sans tout d’abord supprimer l’ancien contenu
de la cellule.

La méthode est similaire à celle décrite ci-dessus,  mais vous devez placer le curseur dans la
cellule. Vous pouvez le faire de deux manières.

Utiliser le clavier
Après avoir sélectionné la cellule désirée, appuyez sur la touche F2 et le curseur sera placé à
la fin de la cellule. Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de
la cellule.

Utiliser la souris
Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur à l’intérieur pour
modification), ou cliquez pour sélectionner la cellule et ensuite déplacez le pointeur de la souris
dans la ligne de saisie et cliquez à l’intérieur pour placer le curseur pour modification.
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Formater les données

Les données dans Calc peuvent être formatées de plusieurs façons. Le formatage peut soit faire
partie d’un style de cellules qui sera appliqué automatiquement, soit être appliqué manuellement à
la cellule. Certains formatages manuels peuvent être appliqués en utilisant les icônes de barre
d’outils. Pour plus de contrôles et d’options supplémentaires, sélectionnez la cellule ou la plage de
cellules voulue, faites un clic droit à l’intérieur et sélectionnez Formater les Cellules. Toutes les
possibilités de formatage sont abordées ci-dessous.

Note
Tous les paramétrages abordés dans cette section peuvent aussi être effectués en
tant qu’éléments d’un style de cellule. Voir le chapitre 4, Utiliser les styles et les 
modèles, du Guide Calc pour plus d’informations.

Formater plusieurs lignes de texte
Des lignes de texte multiples peuvent être saisies dans une seule cellule en utilisant le renvoi à la
ligne automatique ou des retours à la ligne manuels. Chaque méthode est utile dans différentes
situations.

Utiliser le retour à la ligne automatique
Pour que le texte revienne à la ligne en fin de cellule, faites un clic droit et sélectionnez Formater
les cellules (ou choisissez Format > Cellules depuis la barre de menus, ou appuyez sur Ctrl+&
ou Ctrl+1  du pavé numérique).  Dans l’onglet  Alignement (Figure 27),  sous  Propriétés,  cochez
Renvoi à la ligne automatique. Le résultat est montré ci-dessous (Figure 28).

Figure 27 : Boîte de dialogue Formater les cellules > Alignement
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Figure 28 : Retour à la ligne automatique

Utiliser les sauts de ligne manuels
Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur Ctrl+Entrée.
Pour insérer un saut de ligne dans un texte déjà saisi, double-cliquez dans la cellule à l’endroit où
vous voulez faire un saut de ligne (il est aussi possible de cliquer dans la ligne de saisie à l’endroit
concerné) avant d’appuyer sur Ctrl+Entrée.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 29 montre le résultat de la
saisie de deux sauts de ligne manuels après la première ligne de texte.

Figure 29 : Cellule avec sauts de ligne manuels

Ajuster le texte à la taille de la cellule
La taille de police des données d’une cellule peut être automatiquement ajustée pour remplir la
cellule. Pour le faire, cochez l’option  Ajuster à la taille de la cellule dans la boîte de dialogue
Formater les cellules (Figure 27). La Figure 30 montre le résultat.

Figure 30 : Ajustement de la taille de police à la cellule

Formater les nombres
Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes
de la barre d’outils  Formatage. Sélectionnez la cellule, puis cliquez sur l’icône correspondante.
Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic droit sur la
barre puis choisir Boutons visibles et sélectionnez les icônes à afficher.

Figure 31 : Icônes de formats de nombres. De gauche à droite : monnaie, pourcentage, 
date, scientifique, standard, ajouter une décimale, supprimer une décimale.

Depuis Calc 3.3, les nombres formatés avec le format de nombre  Standard sont affichés avec
autant de décimales que nécessaire. Avec les versions plus anciennes de Calc, un maximum de 2
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décimales était affiché avec ce format. Vous pouvez reproduire ce mode de fonctionnement en
sélectionnant  Outils  >  Options  >  LibreOffice  Calc  >  Calcul et  en  choisissant  Limiter  les
décimales pour le format de nombre général.

Figure 32 : Formater les cellules > Nombres

Pour plus de contrôle ou pour sélectionner d’autres formats de nombres, utilisez l’onglet Nombres
(Figure 32) de la boîte de dialogue Formater les cellules :

• Appliquez l’un des types de données de la liste Catégorie aux données.

• Contrôlez le nombre de décimales et de zéros non significatifs.

• Saisissez une description de format personnalisée.

Le paramètre Langue détermine les paramètres locaux pour les différents formats comme l’ordre
dans les dates et le symbole de l’unité monétaire.

Formater la police
Pour choisir rapidement la police utilisée dans une cellule, sélectionnez la cellule, puis cliquez sur
la flèche près du champ Nom de police dans la barre d’outils Formatage et choisissez une police
dans la liste.

Pour choisir la taille de la police, cliquez sur la flèche près du champ Taille
de police dans la barre d’outils  Formatage.  Pour d’autres formats, vous
pouvez utiliser les icônes Gras, Italique ou Soulignage.

Pour choisir  une couleur de police, cliquez sur la flèche près de l’icône
Couleur de police pour afficher la palette des couleurs.  Cliquez sur la
couleur voulue.

Pour  définir  des  couleurs  personnalisées,  utilisez  Outils  >  Options  >
LibreOffice  >  Couleurs.  Voir  le  chapitre  14  du  Guide  Calc  pour  plus
d’informations.

Pour  spécifier  la  langue  de  la  cellule  (utile  pour  permettre  à  plusieurs
langues d’exister dans un même document et d’être vérifiées correctement
(orthographe)), utilisez l’onglet Police de la boîte de dialogue Formater les
cellules. Voir le chapitre 4 du Guide Calc pour plus d’informations.
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Formater les bordures des cellules
Pour choisir rapidement un style de ligne et une couleur pour les bordures d’une cellule, cliquez
sur la petite flèche près des icônes  Style de ligne et  Couleur de ligne dans la barre d’outils
Formatage. Si les icônes Style de ligne et Couleur de ligne ne sont pas affichées dans la barre
d’outils  Formatage, faites un clic droit sur la barre puis choisir  Boutons visibles et sélectionnez
les icônes à afficher. Dans chaque cas, une palette de choix est affichée.

Pour plus de contrôle, comme l’espacement entre les bordures de la cellule et le texte, utilisez
l’onglet Bordures de la boîte de dialogue Formater les cellules. Là, vous pouvez également définir
un style d’ombre. Voir le chapitre 4 du Guide Calc pour plus de détails.

Note

Les propriétés de bordure de cellule s’appliquent à une cellule, et ne peuvent être 
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure haute
(ce qui est visuellement équivalent à une bordure basse dans C2), cette bordure 
ne pourra être supprimée qu’en sélectionnant C3. Elle ne pourra pas être 
supprimée dans C2.

Formater l’arrière-plan des cellules
Pour choisir  rapidement une couleur d’arrière-plan pour une cellule, cliquez sur la petite flèche
près de l’icône Couleur d’arrière-plan dans la barre d’outils Formatage. Une palette de choix de
couleurs, identique à la palette Couleur de police, est affichée.

Pour définir des couleurs personnalisées, utilisez  Outils > Options > LibreOffice > Couleurs.
Voir le chapitre 14 du Guide Calc pour plus d’informations.

Vous pouvez également utiliser l’onglet Arrière-plan de la boîte de dialogue Formater les cellules.
Voir le chapitre 4 du Guide Calc pour plus de détails.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon les conditions que vous
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge.

Note
Pour appliquer un formatage conditionnel, Calculer automatiquement doit être 
activé. Choisissez Outils > Contenu des cellules > Calculer automatiquement.

Voir le chapitre 2 Entrer, modifier et formater des données du Guide Calc pour plus d’informations
sur le formatage conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous
avez à  nouveau besoin  d’un  élément  masqué,  vous pouvez inverser  le  processus  et  afficher
l’élément.

Pour masquer ou afficher  des feuilles,  des lignes ou  des colonnes, utilisez les options du menu
Format ou du menu contextuel (clic droit). Par exemple, pour masquer une ligne, sélectionnez tout
d’abord la ligne et choisissez ensuite Format > Ligne > Masquer (ou faites un clic droit sur l’en-
tête et choisissez Masquer).
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Pour plus d’informations sur comment masquer/afficher des données, en particulier pour utiliser les
outils  Plans et groupes, ou le filtrage de données, voir le chapitre 2,  Entrer, modifier et formater
des données du Guide Calc.

Trier des enregistrements

Le  tri modifie  la  disposition  des  cellules  dans  la  feuille.  Dans  Calc,  vous  pouvez  utiliser
simultanément plusieurs critères de tri, qui sont appliqués l’un après l’autre. Les tris sont pratiques
quand vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est
longue,  il  est  habituellement plus facile d’ajouter  des données en bas de la  feuille,  plutôt  que
d’insérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour
mettre à jour la feuille.

Si les données sont disposées en colonne et comportent un en-tête au format texte,
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules à trier,
puis cliquez sur les boutons de barre d’outils Tri croissant ou Tri décroissant. 

Pour plus d’informations sur les options de tri, voir le chapitre 2,  Entrer, modifier et formater des
données du Guide Calc.

Utiliser les formules et les fonctions

Vous allez sans doute avoir besoin de plus que du texte et des nombres dans votre feuille de
calcul. Souvent le contenu d’une cellule dépend du contenu d’autres cellules. Calc permet de faire
des calculs, des plus simples aux plus complexes en utilisant des formules. 

Pour entrer une formule commencer par saisir le symbole égal (=). Par exemple pour calculer en
A3 la différence entre A1 et A2 :

• Sélectionnez A3.

• Saisissez le symbole = ou cliquez sur le bouton Fonction de la barre de formule .

• Saisissez A1-A2 (en minuscules ou majuscules) ou utilisez la souris :

• cliquez dans la cellule A1 (la référence apparaît dans la formule) ;

• saisissez le symbole – pour calculer une différence ;

• cliquez dans la cellule A2 (la référence apparaît dans la formule).

• Validez par la touche Entrée.

La formule finale doit être :

=A1-A2
La cellule A3 affiche le résultat et la barre de formule affiche la formule comme sur la Figure 33.

Opérateurs principaux Symboles

Addition +

Soustraction -

Multiplication *

Division /

Élévation à la puissance ^ (touche Alt Gr+9)
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Figure 33 : Résultat de la saisie de la formule

Les formules sont des équations utilisant des nombres et des variables afin d’obtenir un résultat.
Les  variables sont  des  emplacements  de  cellules  qui  contiennent  les  données  nécessaires  à
l’équation.

Outre  les  opérateurs  listés  ci-dessus,  Calc  dispose  de  fonctions.  Une  fonction  est  un  calcul
prédéfini saisi dans une cellule pour vous aider à analyser ou manipuler des données. La seule
chose que vous avez à faire est d’ajouter des arguments et le calcul est automatiquement fait pour
vous. Les fonctions vous aident à créer les formules nécessaires à l’obtention des résultats que
vous recherchez.

Par exemple, vous désirez faire la somme des cellules A1 à E1, avec l'opérateur + vous devez
saisir une formule du type :

=A1+B1+C1+D1+E1
Plus le nombre de cellules à additionner sera grand, plus longue et fastidieuse à écrire sera la
formule. LibreOffice permet de simplifier l'opération en utilisant la fonction SOMME qui demande
uniquement l'adresse d'une plage de cellules et non la liste de toutes les cellules. Par exemple :

=SOMME(A1:E1)
Référez-vous au chapitre 7, Formules et fonctions, du Guide Calc pour plus d’informations.

Analyser les données

Calc  contient  plusieurs outils  pour  vous aider  à analyser  les informations  contenues dans les
feuilles de calcul,  allant  des  fonctions pour  copier  et  réutiliser  les données,  à créer  automati-
quement  des  sous-totaux ou encore  à  faire  varier  l’information pour  vous aider  à  trouver  les
réponses que vous cherchez. Ces outils sont répartis entre le menu Outils et le menu Données.

L’un des outils les plus utiles est la Table de pilote (appelé Pilote de données dans Calc 3.3). C’est
un outil pour combiner, comparer et analyser d’importantes quantités de données facilement. En
utilisant  la  table  de pilote,  vous pouvez afficher  différents  sommaires  de source de  données,
afficher les détails de zone d’intérêts et créer des rapports, et ce que vous soyez un utilisateur
débutant,  intermédiaire ou confirmé. Référez-vous au chapitre 8,  Utiliser  la table de pilote, du
Guide Calc pour plus d’informations.

Un autre outil d’analyse de Calc est la possibilité de créer des diagrammes pour visualiser les
données.  Les  possibilités  offertes  sont  très  riches.  Référez-vous  au  chapitre  3,  Créer  des
diagrammes et des graphiques, du Guide Calc pour plus d’informations.

Impression

L’impression  à  partir  de  Calc  est  pratiquement  la  même que  l’impression à  partir  des  autres
composants LibreOffice (voir le chapitre 10, Imprimer, exporter et envoyer par e-mail, de ce guide)
mais certains détails sont différents surtout en ce qui concerne la préparation à l’impression.
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Utiliser les zones d’impression
Les zones d’impression ont plusieurs utilisations, incluant l’impression d’une partie spécifique des
données  ou  l’impression  de  lignes  ou  colonnes  sélectionnées  sur  chaque  page.  Pour  plus
d’informations sur les zones d’impression, voir le chapitre 6, Imprimer, exporter et envoyer par e-
mail du Guide Calc.

Définir une zone d’impression
Pour définir une nouvelle zone d’impression ou modifier une zone d’impression existante :

1) Mettez en surbrillance la plage de cellules qui compose la zone d’impression.

2) Choisissez Format > Zones d’impression > Définir.

Les lignes de délimitation des pages s’affichent à l’écran.

Astuce

Vous pouvez vérifier la zone d’impression en utilisant Fichier > Aperçu. 
LibreOffice n’affichera que les cellules à l’intérieur de la zone d’impression.

Le mode Affichage > Aperçu des sauts de page permet également de 
facilement repérer la zone d’impression sans passer par l’aperçu avant 
impression. 

Ajouter une plage à la zone d’impression
Après avoir défini une zone d’impression, vous pouvez lui ajouter des cellules supplémentaires.
Ceci permet d’imprimer plusieurs zones séparées dans la même feuille, sans avoir à imprimer la
feuille en entier. Après avoir défini une zone d’impression :

1) Mettez en surbrillance la plage de cellules à ajouter à la zone d’impression.

2) Choisissez  Format > Zones d’impression > Ajouter. Les cellules supplémentaires sont
alors ajoutées à la zone d’impression.

Les lignes de délimitation des pages ne s’affichent plus à l’écran.

Note
La zone d’impression supplémentaire sera imprimée sur une page séparée, même
si les deux zones sont sur la même feuille.

Supprimer une zone d’impression
Il peut devenir nécessaire de supprimer une zone d’impression définie, s’il faut imprimer la feuille
entière par exemple.

Choisissez  Format > Zones d’impression > Supprimer.  Ceci  va supprimer  toutes les zones
d’impression  définies  dans  la  feuille.  Une  fois  la  zone  d’impression  supprimée,  les  lignes  de
délimitation de page par défaut s’afficheront de nouveau à l’écran.

Éditer une zone d’impression
À tout moment vous pouvez éditer directement la zone d’impression par exemple pour supprimer
ou redimensionner une partie de la zone. Choisissez Format > Zones d’impression > Éditer.

Sélectionner l’ordre des pages, les détails et l’échelle
Pour sélectionner l’ordre des pages, les détails et l’échelle :

1) Choisissez Format > Page à partir du menu principal

2) Dans la boîte de dialogue Style de page (Figure 34), sélectionnez l’onglet Feuille.
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3) Faites votre sélection et cliquez ensuite sur OK.

Pour plus d’informations sur les  options d’impression,  voir  le chapitre 6,  Imprimer,  exporter et
envoyer par e-mail du Guide Calc. 

Figure 34 : Onglet Feuille de la boîte de dialogue Style de page

Imprimer des lignes ou colonnes sur chaque page
Si une feuille s’imprime sur plusieurs pages, vous pouvez paramétrer le fait que certaines lignes ou
colonnes se répètent sur chaque page imprimée.

Par exemple, si les deux premières lignes, ainsi que la colonne A, doivent être imprimées sur
toutes les pages, effectuez les opérations suivantes :

1) Choisissez Format > Zones d’impression > Éditer. Dans la boîte de dialogue Éditer les
zones d’impression, saisissez les lignes dans la boîte de saisie de texte sous Lignes à
répéter. Par exemple, pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modifier Lignes
à répéter de – aucun – à – défini par l’utilisateur -.

2) Pour répéter des colonnes, saisissez-les dans la boîte de saisie de texte sous Colonnes à
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier  Colonnes à
répéter de – aucun – à – défini par l’utilisateur -.

3) Cliquez sur OK.
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Figure 35 : Définir des lignes à répéter

Note

Vous pouvez également sélectionner les lignes ou colonnes à répéter avec la 
souris. Pour ceci, positionnez le curseur dans la zone de saisie de texte 
correspondante, puis sélectionnez dans la feuille la plage de cellules désirée. Il 
n’est pas nécessaire de sélectionner des lignes ou colonnes entières : une cellule 
de chaque ligne ou colonne suffit.

Sauts de page
Si la définition de zones d’impression peut être un puissant outil, il est parfois nécessaire d’ajuster
manuellement l’impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un
saut de page manuel vous aide à vous assurer que vos données vont s’imprimer correctement.
Vous pouvez insérer un saut de page horizontal au-dessus de la cellule active, ou un saut de page
vertical à gauche de celle-ci.

Insérer un saut de page
Pour insérer un saut de page :

1) Placez le focus sur la cellule où le saut de page va commencer.

2) Sélectionnez Insertion > Saut de page.

3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors paramétré.

Saut de ligne
Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne
Saut de colonne va créer un saut de page à gauche de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

Astuce
Pour voir plus facilement les sauts de page à l’écran, vous pouvez changer leur 
couleur. Choisissez Outils > Options > LibreOffice > Apparence et faites défiler 
la liste jusqu’à la section Classeur.

Supprimer un saut de page
Pour supprimer un saut de page :

1) Placez le focus sur la cellule près du saut de page à supprimer.
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2) Sélectionnez Édition > Supprimer le saut de page.

3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors supprimé.

Note

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la même 
feuille. Si vous voulez les supprimer, vous devez supprimer chaque saut 
individuellement (voir l’astuce suivante). Ce peut être parfois difficile, car bien qu’il 
puisse y avoir un saut de colonne paramétré dans la feuille, quand vous allez à 
Édition > Supprimer le saut de page, le choix Saut de colonne peut être 
indisponible (grisé).

Pour supprimer le saut de page, vous devez être dans la cellule à côté de celui-ci. 
Par exemple, si vous avez défini un saut de colonne alors que vous étiez en H15, 
vous ne pouvez pas le supprimer si vous êtes dans la cellule D15. Cependant, 
vous pouvez le supprimer depuis n’importe quelle cellule de la colonne H.

Astuce
Vous pouvez également utiliser l’option Supprimer tous les sauts manuels du 
menu contextuel si vous avez sélectionné Affichage > Aperçu des sauts de 
page.

En-têtes et pieds de page
Les  en-têtes  et  pieds  de  page  sont  des  morceaux  de  texte  prédéfinis  qui  sont  imprimés
respectivement en haut et en bas d’une page, en dehors de la zone de page. Les en-têtes et les
pieds de page fonctionnent de la même façon.

Les en-têtes et les pieds de page sont dépendants des styles de page. Vous pouvez définir plus
d’un style de page dans un classeur et attribuer des styles de page différents aux différentes
feuilles. Pour plus d’informations sur ces styles, voir le chapitre 4, Utiliser les styles et les modèles
dans Calc, du Guide Calc.

Définir un en-tête ou un pied de page
Pour paramétrer un en-tête ou un pied de page :

1) Sélectionnez  la  feuille  dont  vous  voulez  paramétrer  l’en-tête  ou  le  pied  de  page.
Sélectionnez Format > Page.

2) Sélectionnez l’onglet En-tête (Figure 36) (ou Pied de page).

3) Cochez l’option Activer l’en-tête (ou Activer le pied de page).

À ce stade, vous pouvez également paramétrer les marges, l’espacement et la hauteur de l’en-tête
ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour ajuster
automatiquement la hauteur de l’en-tête ou du pied de page.

Marges
La taille des marges gauche et droite ajuste la distance de l’en-tête ou du pied de page par
rapport aux côtés de la page.

Espacement
L’espacement détermine la distance au-dessus ou en dessous de la feuille à laquelle l’en-tête
ou le pied de page sera imprimé. Ainsi, si l’espacement est de 1 cm, il y aura un espace de
1 cm entre la feuille et l’en-tête ou le pied de page.

Hauteur

La hauteur représente la taille de l’en-tête ou du pied de page.
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Figure 36 : Boîte de dialogue Style de page - En-tête

Pour modifier l’apparence de l’en-tête ou du pied de page, cliquez sur le bouton Plus, ce qui va
ouvrir la boîte de dialogue Bordure / Arrière-plan. À partir de cette boîte de dialogue, vous pouvez
définir l’arrière-plan et la bordure de l’en-tête ou du pied de page. Pour plus d’informations, voir le
chapitre 4 Utiliser les styles et les modèles dans le Guide Calc.

Pour définir le contenu de l’en-tête ou du pied de page (numéro de page, date, etc.), cliquez sur le
bouton Éditer dans la boîte de dialogue de la Figure 36 afin d’afficher la boîte de dialogue En-tête
(ou Pied de page). Pour plus d’informations, voir le chapitre 6 Imprimer, exporter et envoyer par e-
mail dans le Guide Calc.
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